
QCAD
An Introduction to Computer-

Aided Design (CAD)

Andrew Mustun



Trademarks
All mentioned trademarks are trademarks of their respective holder.

Copyright © 2008-2016 by RibbonSoft, GmbH; Andrew Mustun

All rights reserved.  No part of this publication may be reproduced, stored
in a retrieval system, or transmitted, in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without prior written permission
of the publisher.

Mustun, Andrew
QCAD - An Introduction to Computer-Aided Design (CAD)

The author and publisher have taken care in the preparation of this book, but
make no express or implied warranty of any kind and assume no responsibility for
errors or omissions. No liability is assumed for incidental or consequential damages
in connection with or arising out of the use of the information contained herein.
RibbonSoft, GmbH reserves the right to revise and improve its products as it sees fit.
This publication describes the state of QCAD at the time of its publication, and may
not reflect the product at all times in the future.



Table of Contents
Part I: Introduction 7

Introduction 8
Target Audience 8
Structure of 9
How to use this Book 10
Prerequisites 10
From Manual Drafting to CAD 11

Part II: First Steps with QCAD 15

Introducing the QCAD Application 16
The First Start 16
The Application Window 16

Using CAD Tools 19
The CAD Toolbar 19
Starting Tools 20
Correcting Mistakes 21
The Neutral State of QCAD 21
Hands-on: Drawing a Rectangle 22
Hands-on: A Line through the Middle 24
Hands-on: Printing a Drawing 25
Closing QCAD 26

Part III: Basic CAD Concepts 27

Viewing 28
The Viewing Tools 28
Hands-on: Zooming in and out 28
Hands-on: Panning 30
Hands-on: Auto Zoom 31
Hands-on: Window Zoom 31
Notes 33
Exercises 34

Layers 35
What are Layers? 35
Layers, Groups and Blocks 36



Example Uses for Layers 37
The Layer List 38
Layers and Line 38
Hands-on: Using Layers 39

Precision 45
Precision in CAD 45
The Importance of Being Precise 45
Precision Techniques 46
Exercises 46

Snap Tools 47
What are Snap Tools? 47
Snap Restrictions 55
Exercises 57

Coordinates 58
The Cartesian Coordinate System 58
Absolute Cartesian Coordinates 60
Relative Cartesian Coordinates 60
Absolute Polar Coordinates 61
Relative Polar Coordinates 61
Notes 62
Hands-on: Drawing a Triangle from Three Absolute
Coordinates

62

Notes for Advanced Users 63
Hands-on: Drawing a Shape Using Relative Coordinates 64
Hands-on: Drawing a Shape Using Absolute Polar
Coordinates

65

Hands-on: Drawing a Rhombus Using Relative Polar
Coordinates

67

Exercises 69

Part IV: Drawing and Editing with QCAD 71

Drawing Tools 72
Choosing a Drawing Tool 72
Preparations before Drawing 73
Line Tools 73
Arc Tools 84
Circle Tools 90



Ellipse Tools 96
Spline Tools 98
Polyline Tools 102
Shape Tools 109

Selection and Modification 114
Introduction 114
Modification Tools Which Operate on a Selection 114
Modification Tools Which Operate without a Selection 115
Basic Selection Tools 116
Advanced Selection Tools 119
Basic Modification Tools 125
Advanced Modification Tools 135

The Property Editor 166
Filtering Entity Types 169

Measuring Tools 172
Introduction 172

Texts 176
Texts in CAD 176
Fonts 176
Text Height 177
Creating Text Entities 177
Subscript and Superscript 179

Dimensions 181
What Are Dimensions? 181
The Parts of a Dimension 182
Dimension Preferences 183
Creating Dimensions 184
Choosing a Different Text Label 194
Moving the Text Label 198
Moving Reference Points 199
Stretching Dimensions 200

Hatches and Solid Fills 202
What Are Hatches? 202
What Are Solid Fills? 203
Creating Hatches and Solid Fills 203



Part V: Blocks 209

Creating and Using Blocks 210
What is a Block? 210
The Block List 212
Creating New Blocks 213
Inserting Blocks 215
Modifying Blocks 217
Deleting Blocks 219
Exploding Block References 220

Part VI: Import, Export and Printing 221

Import 222
Bitmap Import 222
SVG Import 224

Export 225
Exporting Drawings 225
Bitmap Export 225
SVG Export 227
PDF Export 228
DXF Export 229

Printing 230
Printing a Drawing 230
Printing a Drawing to Scale 232

Part VII: Projections 235

Orthographic Projections 236
Views of an Object 236
Local Standards 237
Drawing Techniques 239
Hands-on: Orthographic Projections 242
Exercises 253

Isometric Projections 255
What are Isometric Projections? 255
Creating Isometric Projections 256
The Scale of Isometric Projections 260



Part II

First Steps with QCAD



Using CAD Tools Chapter 3

22

Alternatively, you can also click the right button of your mouse to return back to the neutral state
step by step. Depending how far you have progressed with a tool, you might have to click the right
mouse button more than once to fully return to the neutral state. The same can also be achieved
by hitting the Escape key on your keyboard a multiple times.

Hands-on: Drawing a Rectangle

The following instructions guide you through the complete procedure of drawing a simple rec-
tangle. You will probably not yet understand all steps involved but it is crucial that you success-
fully complete these steps since all CAD tools work in a similar way like the rectangle tool.

Figure 3-3: Choosing the CAD tools for draw-
ing rectangles and activating the Snap to grid tool.

1. Launch QCAD if it is not already running. QCAD shows its application window and
creates a new, empty drawing.

2. Before you start drawing anything, save this empty drawing to a file on your disk. To do
so, choose the menu File - Save As...
The dialog for saving a drawing is shown. The dialog automatically suggests a location
for your file. This location is usually not a bad place to start with. You might want
to use a sub-folder drawings in this location instead, but to keep things simple the
following steps assume that you use this default location for saving your drawing.

3. Type the filename example into the input field with the label File name, then click the
Save button to save the empty drawing. The dialog window closes and you are now
ready to start drawing.
Although is is not necessary to first save the empty drawing, it is good practice to do so
as it forces you to think about where you want to store the file before you start drawing.

4. Move your mouse cursor to the shape button as shown in Figure 3-3 at the left (1). Click
the left mouse button to show the shape tools (2).

5. Click the button with a rectangle on it as shown in Figure 3-3 (2). QCAD now knows
that you intend to draw a rectangle and shows the CAD toolbar with the snap tools.

6. Click the button with a grid on it as shown in Figure 3-3 (3).
7. Move the mouse cursor around in the drawing area. There are two things to notice:

• The mouse cursor has changed its shape and is now shown as a pair of cross hairs.
• There is a small yellow circle that follows the mouse cursor around whenever

you move it. This circle is not positioned exactly under the mouse cursor. It
‘snaps’ always to the grid point in the drawing area that is the closest to the mouse
cursor.
This yellow circle indicates what position QCAD is currently working with. The
exact position of the crosshair mouse cursor is irrelevant to QCAD as long as the
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yellow circle is in the correct place. In the previous step you have chosen to use
the grid for positioning (Snap to grid). QCAD is now automatically restricting the
options for choosing a position to the grid points.

8. Click somewhere into the drawing area. A little red circle with a cross appears at the
closest grid point as shown here:

You have now set the first corner of the rectangle you are about to draw. If you move
the mouse cursor around in the drawing area, you will see that QCAD draws a rectangle
from the chosen position to the grid point that is closest to the mouse cursor as shown
below:

Note that this rectangle is not yet part of your drawing and keeps changing whenever
you move the mouse. This is called a preview. QCAD uses these previews to show you
what would be drawn if you would click the mouse button at this point.

9. Move the mouse cursor until the rectangle that is shown is three grid spacings wide and
two grid spacings high. Your rectangle should look like that one in the figure above.

10. Click the left mouse button to set the second corner of the rectangle. This leaves you
with a drawing that looks like this:

The rectangle that is shown now, is a part of your drawing.
11. QCAD is ready to draw the next rectangle and waits for the first corner of the next

rectangle. Since we don't want to draw more rectangles, we will terminate this tool now.
To do so, click the right mouse button twice. If you don't have a right mouse button,
press the Escape or Esc key on your keyboard twice. The mouse cursor is back to
normal and the CAD toolbar shows the same tools as it did after starting QCAD. Your
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rectangle should still be visible. If that is not the case, you did something wrong and
you need to carefully repeat the steps 4 to 10.

12. Save your drawing by choosing the menu File - Save.

In the example you have just completed, you have used a tool called Snap to grid. As a result, the
corners of the rectangle are exactly aligned to the grid points. Snap tools are a central concept of
any CAD system and there are many other snap tools you will get to know later in this book.

Hands-on: A Line through the Middle

To emphasize the importance of snap tools, we will now extend our drawing with a vertical line
that separates the rectangle in two equal halves.

Vertical means that the line extends from a first point to another point directly under or above it.
In our case, the line starts in the middle of the top line of the rectangle and ends in the middle of
the bottom line. The top and bottom lines of the rectangle are horizontal, that means they extend
from left to right. You can easily remember what horizontal means by thinking that the horizon at
the seaside looks horizontal.

Note that there are no grid dots at the center of the top and the bottom line of the rectangle. For
this line we will have to use a different snap tool.

Figure 3-4: Choosing the CAD tool for drawing lines with two
points and changing the snap tool to Snap to middle points.

1. Choose the Line Tools button again from the CAD toolbar as shown in Figure 3-4 (1).
2. This time, select the tool Line from 2 Points (2).
3. Click the button Middle (3). This activates the snap tool to snap to middle points of lines

and arcs. Note that only one snap tool can be active at any time.
4. Move the mouse cursor around in the drawing area like we did before with the grid

snaptool. As you can see, the yellow circle no longer jumps from grid point to grid
point. Instead it now only shows up in four different positions which are the middle
points of the four lines that form the rectangle. One such possibility is shown here:
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Chapter 8

Coordinates

Objective

In this chapter, you will

• learn what coordinates are,
• get to know the different types of coordinates QCAD supports,
• learn how to define positions by entering coordinates.

The Cartesian Coordinate System

In the previous chapters you have already seen and used the drawing area of QCAD. Like a sheet
of paper, the drawing area is a flat area onto which you can draw something.

When working with a CAD system, you will often be confronted with the coordinate system of
the drawing area. A coordinate system uniquely defines each point in the drawing area and in
your drawing. If you point with a pen to any position in the drawing area, that position has a
unique coordinate that defines where this point is in the drawing.

By far the most commonly used coordinate system is the Cartesian coordinate system. A coor-
dinate system is not something that is given by nature. Coordinate systems were defined once by
someone (in this case René Descartes in 1637) to define a standard for specifying the position of
a point on a two dimensional surface. The Cartesian coordinate system is not only used in CAD
applications but in many areas of mathematics, physics and engineering.

The Cartesian coordinate system is based on two axes that are at right angles (orthogonal) to each
other. The horizontal axis is commonly called the X-axis while the vertical one is called the Y-
axis as shown in Figure 8-1.
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Figure 8-1: The coordinate axes of the Cartesian coordinate system.

The origin of the coordinate system is the point where the X and the Y axes cross each other. This
point is also referred to as the absolute zero point or just absolute zero.

Both axes have a direction. The X-axis is directed to the right and the Y-axis upwards. This is
not necessarily a logical choice, it was simply defined this way. As you can see in Figure 8-1, the
axes are divided into smaller sections, each one unit long.

Any particular position can be described by its distance from the origin in X-direction and in Y-
direction. For example the position of the point P in Figure 8-2 is 3 units away from the origin
in X-direction and 2 units away from the origin in Y-direction. Or, to use the correct notation,
the point P is located at (3,2). This notation in brackets indicates the location of a point as a pair
of an X-distance and a Y-distance (X,Y).

Figure 8-2: The location of the point P can be noted as (3,2) where 3 is the dis-
tance to the origin in X-direction and 2 is the distance to the origin in Y-direction.

If a point is located left of the origin, its X-coordinate turns negative. If it is located below the
origin, its Y-coordinate turns negative. Figure 8-3 shows some points in the Cartesian coordinate
system and their (X,Y) notation. The (X,Y) notation for the origin is (0,0).
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Preparations before Drawing
Before you draw anything you should set up the layers of your drawing as described in a previous
chapter. The drawing tools of QCAD always draw all objects on the layer that is currently active.
After creating a new empty drawing, spend some time to think about the layers you will be using
for your drawing and create them. Whenever you are about to draw something, have a look at
the layer list at the right to make sure that you are on the correct layer. It can be helpful to assign
different colors to different layers, so you immediately realize that something is wrong if you
draw on the wrong layer.

Line Tools

Menu: Draw > Line
Keycode: WL

 
QCAD offers a variety of tools for drawing lines. They are all available in the CAD toolbar of
QCAD after clicking the line button shown in Figure shows the CAD toolbar with the various
tools for drawing lines.
Note that you can click the button at the top with the left arrow to return to the main menu.

Figure 9-2: The CAD toolbar showing the drawing tools for drawing lines.

Line from two Points

Menu: Draw > Line > Line from 2 Points
Keycode: LI

 
With this tool you can draw a single line by directly defining its start point and end point. It is
also possible to draw a series of connected lines.
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Drawing a single line

1. Click the start point of the line.
2. Click the end point of the line.
3. Terminate the tool by clicking the right mouse button twice or by pressing the Escape

key on your keyboard twice.

Figure 9-3: Example for drawing a single line with startpoint and endpoint.

Drawing a series of connected lines

1. Click the start point of the first line.
2. Click the end point of the first / next line. Repeat this until you have drawn all

connected lines you want to draw.
3. Terminate the tool by clicking the right mouse button twice or by hitting the Escape key

on your keyboard twice.

Figure 9-4: Example for drawing a series of connected lines.

Drawing a series of disconnected lines

1. Click the start point of the first / next line.
2. Click the end point of the first / next line.
3. Click the right mouse button once or hit the Escape key on your keyboard once.
4. Repeat steps 1-3 until you are finished with drawing lines.
5. Terminate the tool by clicking the right mouse button twice or by hitting the Escape key

on your keyboard twice.
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Figure 9-5: Example for drawing a series of disconnected lines.

Line with fixed Angle

Menu: Draw > Line > Line from Angle
Keycode: LA

 
This tool lets you draw lines at a fixed angle. The length of the line can be specified and you can
choose if you want to position the line by defining its start point, middle point or end point.
When you are using this tool, you will often find that the length of the line is irrelevant at first
and can be better adjusted later using a trim tool.
Usage

1. Enter the angle of the line in the options toolbar. Type a length for the line and choose
how you want to position it.

2. Click the position of the line. You can also repeat this to place more than one line with
the same angle or change the angle in the options toolbar at any time.

3. Terminate the tool by clicking the right mouse button twice or by hitting the Escape key
on your keyboard twice.

Table 9-1 shows three example uses of this tool.

Table 9-1  Line with Fixed Angle
Tool options Click point and constructed line

Angle: 30
Length: 20
Snap Point: Start

Angle: 45
Length: 30
Snap Point: Middle

Angle: 60
Length: 20
Snap Point: End



Selection and Modification Chapter 10

156

Rounding Corners (Fillet)

Menu: Modify > Round
Keycode: RN

 

This tool is used to round corners. It works very similarly to the chamfering tool.

Usage
1. Start the round tool.

2. Enter the radius of the rounding in the options toolbar.
Make sure that the Trim check box is ticked if you want to automatically trim the corner
lines to the rounding.
For this example, we want to create a rounding with a radius of 4.5 units with trimming
enabled:

3. Pick the first entity that forms the corner you want to round.
In our example, we click the top line of the rectangle as the first line of the top right
corner which we want to round:

4. Move the mouse cursor to the second line of the corner. QCAD shows a preview of the
rounding you are about to create. At this point it is important to place the mouse cursor
at the correct side of the line since there are two roundings possible.
If you place the mouse cursor somewhat to the right of the vertical line, an alternative
rounding is shown:

Move the mouse cursor somewhat to the left of the vertical line to show the rounding
we want to create:

5. Click the left mouse button when the preview shows the correct rounding.
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6. QCAD creates an arc that is tangential to the two chosen lines and trims the lines to the
arc as shown here:

7. The other corners can be rounded in the same way:

Dividing Entities

Menu: Modify > Divide
Keycode: DI

 

This tool divides (or cuts) an entity at a given point. You can for example divide a line into two
parts. The division point must be on the entity and is in most cases an intersection point with
another entity.

Entities often have to be divided to change the line style in the middle of an entity or to form
closed contours for hatching or solid fills.

In the example in Figure , the original shape of a mechanical part before bending is shown with
a dash-dot-dot line in the view at the bottom.

Figure 10-14: Lines often need to be divided to apply dif-
ferent layers or line styles to the two separate parts.

Usage
1. Start the dividing tool:
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